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For observing specimens, most adequate values must be selected for various conditional parameters such
as acceleration voltage, irradiation current, movable aperture, and working distance. '

Also a sampling method (preparation of specimens) and specimen tilt must be considered. In addition,
adjustments of luminance, astigma and focus are important for obtaining best image quality.

4.1.1 Difference of image quality due to the level of acceleration

voltage

The higher the acceleration voltage, the thinner the electronic probe diameter, provided that only electronic
probe diameter is theoretically taken into account; however, drawbacks appearing when using a high
acceleration voltage cannot be disregarded. Some main points thereof are listed below:

o o0 oo

The fine structure of the specimen surface is susceptible to damage.
Edge effect becomes significant.

Charge-up tends to easily occur.

Specimen damage tends to easily occur.

Generally, opefation at low acceleration voltages results in fine structures more significantly appearing on
the specimen surface. At high voltages, the entry/diffusion area of the electron beam in the specimen is
larger, and accordingly unnecessary signals (e.g., reflected electrons) occurring from inside the specimen
deteriorate the contrast, thereby causing the fine structure on the specimen surface to be invisible. Thus,
low acceleration voltages are particularly preferred for observing low-density substances.

Image of surfa
| -siructure is sharp; -
1 :.Darqiage’is*le

Furface v




4.1.2 Effect of probe current

As the diameter of the electronic probe irradiating a specimen is smailer, the higher magnification ratio and

resolution of SEM can be obtained. However, under such conditions, the smoothness of an image, i.e., the
The smaller the

S/N (signal/noise) ratio of the image, depends on the current irradiated to the specimen.

irradiation current, the smaller the electron beam probe diameter.
suitable for the specimen, magnification, and observation conditions (acceleration voltage, specimen til,

efc.) Is required.

Thus, selecting an irradiation current

P.C. value
Resoiution
Probe diameter
Probe current

:+ || Condenser lens
=1 current

1| Specimen damage

image qualify

0
High
Small
Small
Large

Insignificant
Rough

-

Indication of setting an probe current

[99.9]
Low
Large
Large
Small

Significant
Smooth

4.1.3 Effect of the working distance (WD) on images

Regarding the working distance (WD), high resolution with 2 small depth of vision is obtained at a short WD,
and on the contrary a large depth of vision with low resolution is resulted at a long WD. Select most suitable
observation conditions considering other factors such as sampling method and specimen filt.

adjusting luminance, astigmia and focus is also important for obtaining best images.

deep.

Depth of vision is: -

In addition,
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4.1.4 Effect on images by aperture diameter

The aperture (movable aperture) of the object lens set on this equipment as standard is configured by three
stages: 20, 30 and 60 pm¢. To obtain high resolution, a most suitable aperture diameter must be selected.
However, the aperture diameter should not be adjusted small to a level more than necessary since a
sufficient quantity of signals is required for forming an image on this equipment in addition to the thinness of
electron beam. Select the following values for respective purposes of observation: 20 pmé¢ for
high-resolution observation, 30 pm¢ for normal observation or EDS analysis, and 60 pm¢ for WDS analysis,

for example, where a large current is required.

: .analysw. : tc )

4.1.5 Relation between specimen tilt and emission electron

When electron beam is irradiated fo a specimen, secondary electrons are emitted from relatively shailow

locations. This happens because secondary electrons, which have low energy, cannot reach the gpecimen

surface when they are produced in deep locations.
However, in portions of the specimen where it is tilted, primary electrons enter into a wide area at small

angles, and thus secondary electrons produced inside the specimen easily reaches the surface, resulting in
a large emission quantity of secondary electrons.

This phenomenon may cause only the tilted portion of the observed specimen to be displayed in white
(called “halation”). To reduce halation, turn the tilted surface toward the opposite of the secondary electron
detector {dowrward in the observation window). If still not enough, then a filter for secondary electrons is

effective. With this filter, the quantity of signals is limited, offering more effective reduction of halation.

Tap A of photo data/signal and
check "Filter” in the Signal window.

Advaneed




4.1.6 Observation and charge-up of nonconductive specimen

Charge-up may be observed when irradiating the electron beam to a nonconductive specimen at high
acceleration voltages or with large probe current, where electrons are accumulated on the specimen surface.

If this happens, shifts or variation in brightness of the obtained images might be resulted due to such effects

as the track of primary electron beam being changed or the production of secondary electrons being

constrained.
With this type of specimens, observation in reduced charge-up is possible through establishing a low

acceleration voltage or low vacuum (LV) mode. _
Marecver, charge-lip can be reduced by tilting the specimen to increase emission electrons.

.
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4.2.1 Temporarily shutting off the electron beam

Temporarily shutting off the electron beam can prevent damage of the specimen.

1. Tap the [Beam Blanking icon from Home.
The electron beam is shut off.

To release the shutoff tap the Beam Blankm icon again.

4.2.2 Matching the focus current to WD

Matchi'ng the focus current to the present WD offers a most suitable focus.

1. Tap A mark under WD of the photo data.
In the below figure, tap the A mark under WD 10.0mmJ , and WD window is displayed.

2. SetaWD.
Tap the preset button or use the slide button for setting.

The value set by using the slide button is displayed in the upper mlddle of the slide bar.
" Preset button

Set value

Slide button

Changing the preset button

preset button desired to change. The value of the preset button changes.

Drag the value selected by using the slide button (upper middle of the slide bar) and drop it on the




4.2.3 Making the focus follow Z-axis displacement

(Auto-focus tracer)
This function is for automatically, synchronously letting the focus follow the Z-axis displacement.

1. Tapthe icon from Settings.

. The Stage Settings window is displayed.

0 Focus Tracer

: High Resolation Moda,

rarne Travel Rate. -

Tnitialize

Make sure to remove the specimen holder before stage calibration.

"



4.2.4 Observing at high resolution

To establish high resolution, the WD must be shortened.
The WD is normally limited to 8 mm, but the following operation enables reducing the distance to as small as

5mm:

1. Tapthe icon from Settings.

The stage setting window is displayed.

5 . fmage

2. Check High Resolution Mode. 7
The stage can be displaced to as smallas 5 mmWD.

Care must be taken that, if a wrong specimen height is set even though the specimen actually protrudes
from the specimen holder, an accidental contact might occur with paris inside the specimen

compartment, thereby damaging the parts. = See 3.6.




4.2.5 Irradiating large currents to a specimen

Use this function for the case requiring large currents, such as WDS analysis.

1. Tap A mark under P.C. of the Photo data.
In the below figure, tap the A mark under [Std.-P.C.50.0J , and Probe Current window is displayed.




4.2.6 Displacing a target object at fine steps

{Beam shift)
Use this function for the high observation magnification of several thousands- or more.

1. Tapthe icon.

The manual adjustment tool is displayed.

Tap the Bearn Shiff button.

Tap respective buttons to displace an image.
Continuously pressing the buttons continuously displaces the image in the directions corresponding to

the buttons.

SYN

Shrg ’ [ .

| Brigatness
4Y Direction] buiton
button
-+ X Direction] button
button
button
[Resef button




(Beam shift reset)
Use this function for resetting the beam shift amount.

1. Tapthe icon and the [Beam Shiff button.
2. Tapthe button.

The beam shiit is reset.

There is a limit on displacement using the beam shift.
Upon reaching the displacement limit, no more displacement using the beam shift is possible.
The present amount of beam shift displacement can be identified with the location displayed on the indicator,

which is positioned at the center of the manuat adjustment tool.

Example: When the beam shift reaches the limit in the direction of +X

Upon reaching the displacement limit, reset the beam shift-in the above-mentioned operation and conduct

displacement again by using the stage.

2



4.2.7 Displacing an image as a frame

1. Tap the icon from Settings.

The Stage Settings window is displayed.

Imuage -

2. Check Frame Travel Rate and set a proporﬁdn by using the slide button.
The set proportion is displayed in the upper middle of the slide bar.

Set proportion

High Resolution Mode

Frame Travel Rate. '

Slide button

3. Inthe main window, tap the stage displacement button corresponding to the direction desired to
displace. L :

4. The image is displaced by a set percent value in the direction shown on the button.
For example, setting a frame displacement amount of 50% makes displacement equivalent to half a

frame and 100% makes that equivalent to a full frame (one image).



4.2.8 Correcting focus blur or magnification error due to stage
tilt

4.2.8.a Correcting focus blur

(Dynamic focus) .
Focus blur occurs in the observation window when conducting observation by tilting the specimen stage

T-axis.
Using the dynamic focus function enables correction of focus blur due to T-axis tilt.
Set the scan rotation angle to zero degree for correcting focus blur in the tilt direction of stage T-axis.

1. Adjust the focus at the center of the observation image.
Befare the focus adjustment, set the scan rofation angle to “0°."

= See4.2.0.

2. Tap the [Dynamic Focus|icon from Home.
The Dynamic Focus window is displayed. _
Check the “Enable" c_:hec_kb_ox'. If already checked, this operation is not necessary.

t-1.. Dynam )
LFreus |

3. Swiitch the scan mode to [Slow, and adjust the focus for the entire observation window by using

the slide button.
A correction amount is displayed in the upper middle of the slide bar.

Correction amount

Slide bufton

The corrected amount is retained even after closing the dynamic focus window.
To release the correction, set the correction amount to zero by using the slide button.



4.2.8.h Correcting a magnification error

(Tilt Mag. correction)

Magnification variance may occur in the observation window when conducting observation with the
specimen stage T-axis being filted. :

Use the tilt mag. correction function for correcting the magnification variance due to T-axis tilt.

Before using the equipment, set the scan rotation angle to zero degree for correcting a magnification error in

the tilt direction of the stage T-axis.

1. Adjust the focus at the center of the observation image. |
Before the focus adjustment, set the scan rotation angle to "0°.”

= See 4.2.9.

2. Tap the(Tilt Mag| icon from Home.

The Tilt Mag Correction window is displayed.
Check the “Enable” checkbox. If already checked, this operation is not necessary.

3. Switch the scan mode to and adjust the correction amount by using the siide button.
A correction amount is displayed in the upper middle of the slide bar.

Correction amount
Slide button

The correction amount is retained even after closing the trapezoidal correction window.
To release the correction, set the correction amount to zero by using the slide button.



4.2.9 Rotating an image

(Scan rotation)
Use the scan rotation function for rotating the image in the observation window by rotating the scanning

direction of the electron beam on the specimen instead of directly rotating the specimen.

1. Tapthe icon.

The manual adjustment tool is displayed.

2. Tapthe button and rotate the image by referring to the following illustration:

Tapping the 0.1° Rotation} button or 0.1° Rotation| button rotates the image by +0.1° or -0.1°. - In

addition, continuously pressing the button continuously rotates the image.

Tapping the button (' or button) rotates the image by 90° (180° or 270°) from "0°” as the
reference. '
Tapping the [Reset (0° )| button makes reset the rotation ahgle_ to0° .

Present rotational angle Reset (0° )| button
bution _ button |
—0.1° Rotation| button
Iﬁ button /‘},
button

The image is continuously rotated by rotating the mouse whee! or continuously pressing the
left button with the mouse cursor located on the button or button.
* Using a mouse wheel enables rotation in both directions on one button.

Example: Rotate the mouse wheel by locating the mouse cursor on the button.

= Continuous rotation at the rate of or is possible.




(Scan horizontal correction function and scan vertical correction function)
The target object can be corrected horizontally or vertically by using a straight line drawn on the observation

image.

Example: Case of scan horizontal correction

1. Tapthe icon.
The manual adjustment tool is displayed.

v v,

IScan Horizontal correction] button

3. Specify beginning and ehd 'pq'ént_s:-'rofa' line éiong the target object desired to horizontalize in the
main window. ' o N _ :

4. The target object is horizontally corrected.
Scan rotation horizontally corrects the target object.
3 When selecting scan vertical correction, the target object is vertically corrected.



&

Check ON/OFF of SRT function
The button is selected, and put the mouse cursor on the center of manual tool, SRT ON (Enable)/ OFF
(Disable) is displayed as below.




L

4.2.10 Avoiding vision shift due to stage rotation

4.2.10.a Eucentric R function

A target object can be visualized at the center of the observation window without losing the sight of the object

by rotating the stage as if the object were actually rotating.
3% Use this function at a magnification of x1000 or less, as using it at a high magnification might

lose the sight of the target object.

1. Tap the coordinates display field.
The Stage Operation window is displayed by tapping outside the SRT display field.

Absolute -

oftware Keyboard ¢

3. Enter a rotation angle into R and tap the button.
Ensure that the target object is rotating at the center of the main screen.
Continuously press the eucentric R _d_isplacemen_t button of the main screen for continuously displacing

the ucenric :




4.2.10.b Stage horizontal correction function

The target object can be corrected horizontally by using a straight line drawn on the observation image.
% Use this function at a magnification of x1000 or less, as using it at a high magnification might
lose the sight of the target object.

1. Tap the coordinates display field.
The Stage Operation window is displayed by tapping outside the SRT display field.

WT=asgi0s

Eescantric

Relative

3. Specify beginning and end points of a lihe along fhe'iarget object desired to horizontalize in the
observation window

4. The target object is horizontally corrected.
The target object is horizontally corrected by rotating the stage R-axis.



'4.2.11 Preventing vision shift due to the variance of specimen

heights

(Eucentric T function)
Thig function can prevent vision shift in the Y and Z-axis directions due to the T-axis tilt caused by the height

variance of specimens. The function is effective for entering a protrusion amount of the specimen (or height

of the specimen) when mounting it.
% Use this function at arma'g'nification of x500 or less, as using it at a high magnification might lose

the sight of the target object.
3 In case a variance exists between the actual specimen height and the specimen height entered

when mounting it, the sight of the target object might be lost.

1. Tap the coordinates display field.
The stage operation window is displayed by tapping outside the SRT display field.

xelmBeanTR Y=4.571mm o Z=20.000Mm ¢

Absvlute

tware Keyboardd

3. Enter a rotation angle into T and tap the button.

Ensure that the target object is visible within the cbservation range.
Continuously press the eucentric T displacement button of the observation image for continuously

displacing the eucentric T.

bufton

Negative movement

button

Positive movement




4.2.12 Obtaining an anaglyph image

Anaglyph image is defined as an image visualized in three dimensions through red-blue glasses.

1. Tapthe icon from Home.

The 3D Imaging window is dispiayed.

2. Tap the JAnaglyph Image] icon and then the [OK] button of the confirmation message.
The scan rotation is automatically set to a status suitable for obtaining a reference image of the

Bl Preparisg for anaglyph ima Satting scan rotation to 5on,

Titing stage for anafg[yph imaging

4. Specify the tilt angle of the specimen stage and tap - button.
The specimen stage moves at specified angle, it is set in a state suitable for creating anaglyph image.




R—

5. Wear red-blue glasses and obtain an anaglyph image by following the guide messages.

Superimpose the reference and tilted images, and, upon finding a point visualizing the object in three

dimensions, tap the icon.

Displacing the stage by dragging is convenient when superimposing the images. = See 3.9.2.

f 2. Put on the anaglyph glasses so tat the o ight aye looks
i rhmuqn fhn biue glass. Then click tlw hu‘ton an the nqhi

Display Reference Image. : When you check i, the reference image is displayed onto the tilted image.

Reference Image : RED
Tilted Image : BULE

After obtaining an anaglyph image, tap the W IClose| button of the confirmation message.
Anaglyph imaging is terminated.

Observation conditions are reset to those prior to anaglyph imaging.
The file of the obtained anaglyph images is named and saved as
“Reference image file name + Anaglyph.”

Wear red-blue glasses for viewing the anaglyph images.



4.2.13 Obtaining a three-dimensional measurement image

This function enables easy saving of two images having different angles and a same vision (stereo pair).
Using these two images and the optional three-dimensional software, the function shows a bird’s-eye view
enabling three-dimensional observation of images and specimen structure, thereby allowing dimensional

measurement of spatial structure from the bird’s eye view, _
For details of the three-dimensional software, see the operating manual of the three-dimensional image

software.

1. Tapthe icon from Home.

The 3D Imaging window is displayed. . :

Eiéci'rgn . Beam, . Wohbier. Regi

D Imaging Main Menu

Applcation

4. Specify the tilt angle of the specimen stage and tap @ button.
The specimen stage moves at specified angie, it is set in a state suitable for creating 3D analysis image.

—



5. Obtain a tilted image by following the guide messages.
Upon superimposing the reference and tilted images, tap the icon.
Display Reference Image. : When you check It, the reference image is displayed onto the tilted image.
Reference Image : RED
Tilted Image : BULE

6. Upon obtaining a tilted image, tap the button of the confirmation message.
Three-dimensional imaging is terminated.

Observation conditions are automatically reset to those before obtaining tited images.
The file of the obtained three-dimensional images (a pair of two images) is named and saved as

“Reference image file” and "Reference image file name + Tilted.”

Case of the optional three-dimensional image software being instailed:

As 'a message prompting startup of the three-dimensional image software is displayed, start the
software as desired. For details, see the operating manual of the optional three-dimensional image

software.

s’



4.3.1 Conducting measurement by using a micron 'bar

Dragging the micron bar into the main window enables simple measurement of lengths.




4.3.2 Measuring the distance between lines (X, Y and diagonal)

1. Tapthe icon from Home.

The Ruler window is displayed.

2. Select Parallel for the Ruler type and select the ruler direction.
Lateral direction: Select |Parallel X (Two cursors are displayed in the vertical direction.)

Longitudinal direction: Select{Parallel Y. (Two cursors are displayed in the horizontal direction.)
Diagonal direction:  Select [Diagonal. (Two cursors are dispiayed in each of the horizontal and
vertical directions.) o

Example: Case of selecting the diagonal direction (Diégoné!)

3. Drag the displayed cursor and set a measurement point.
Case of the laterallongitudinal direction:  Drag the cursor corresponding to each direction.

Case of the diagonal direction: Drag the cross point of the cursors.

Measured values are displayed in the upper left of the screen in real time.



4.3.3 Measuring the distance between two points

1. Tapthe icon from Home.
The Ruler window is displayed.

3. Tap the beginning and end points of'_th'e target object.

The line segment connecting the beginning and end points is determined, and the distance is displayed.

L



4.3.4 Measuring the total distance of straight lines connecting
multiple points

1. Tapthe icon from Home.

The Ruler window is displayed.

open ..

Parail=! -

3. Specify the beginning point of the target object and then a junction point in an arbitrary position.
Successively conduct this operation.

4. Double-tap the end point of the target object.
The line segment connecting the beginning, junction and end points is determined, and the total

distance is displayed. :
Doubie-tap




4.3.5 Measuring an angle

1. Tapthe icon from Home.

The Ruler window is displayed.

bler Recipes | Histogram £ Ruiler,
o Trnaugiriy

3. Sequentially tap the beginning, apical and end points of the target object.
The angle to be measured is determined and the measured value is displayed.




4.3.6 Measuring the area of a circle (or ellipse)

1. Tapthe icon from Home.
The Ruler window is displayad.

icon.

€. . Parcilel

3. Draw a circle (or ellipse).
An inscribed circle (or ellipse) is drawn in a rectangle by sequentially tapping the beginning and end
points in & manner similar to the case of drawing a diagonal line for a rectangle,

Upon completing the drawing, the area of the circle (or ellipse) is displayed.
o




4.3.7 Measuring the area of a rectangle

1. Tapthe icon from Home.

The Ruler window is displayed.

i

.tleciran
Gt

Parailsd -

3. Specify an opposite vertex fo determine the domain of a rectangie.
A rectangle is drawn and its area is displayed.




4.3.8 Counting the number of target objects

1. Tapthe icon from Home.
The Ruler window is displayed.

g Y

Histegram LuT...

dibration.

3. Sequentially tap the target objects subject to counting.
The marks "+ are displayed and the total number thereof is displayed.




4.3.9 Entering a text in the observation window

1. Tapthe icon from Homne.
The Ruler window is displayed.

¥ . Raport | Mode O S| E £ Histpgram AUT 30D Movia
: . = ' g .

3. Inthe observation window, tap a position into which a text is desired to insert.




4. Entering a text and pressing the key confirms the text.
The color, font and size of the text conform to Windows OS.

Dragging the confirmed text enables displacing the displaying location.
Dragging M in the text box enables the scaling of the box.




4.3.10 Changing the color and font of a text

1. Changing the color
a. Bring up the Color selection window by tapping the icon.

b. Selecta color, and tap the button.

Ruler Typa

2. Changing the font -
a. Bring up the Font window by tapping the icon.
b. Select a font, and tap the [OK] button.




4.3.11 Inserting an arrow in the observation window

1. Tap the icon from Home.
The Ruler window is displayed.

Made-:Full
reeq
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4.3.12 Changing the color and/or font of the location subject to
measurement

1. Tapthe icon from Home.
The Ruler window is displayed.

parsilel




4. Change the color and/or font.

Changing the color
Bring up the color selection window by using the icon, select a color, and tap the [Apply] button.

Parallel

Changing the font S '
Bring up the font window by using the icon, select a fant, and tap the [OK] button.




4.3.13 Deleting a measurement location and/or text box

1. Tapthe icon from Home.

The Ruler window is displayed.

Ruler

4. Tap the icon.

The location for length measurement andfor the text box selected is deleted.
% If all are desired to delete, tap the Delete All icon regardless of selection.

Parailst




4.3.14 Calibration of Ruler

Measurement accuracy of the factory adjusted for each device, but if you want to measure higher accuracy
depending-on application, please calibrate by the following procedures

¥Please prepare for the specimen which becomes the standard of the length by a customer yourself.

If you calibrated with accelerating voltage and WD you want to use, you can measure more strictly.

1. Tapthe icon from Home.
The Ruler window is displayed.

- Parafigl’

3. Align the vertical cursor to the calibration standard.
Current value display o -




4. Input a calibration value for the displayed horizontal distance and tap @] button.

Toreget horizontal calibretionto t

|
|
-

Unit change icon

% When you wish to befoul the calibration value , tap the icon.
{(at shipment from the factory)
#  Input range of the calibration value is +3% of the default value.

5. The vertical direction of the calibration.
Perform the same way as the Step 2-4.

6. Tap the [Exif button to exit the calibration.
The measurement value on GUI is displayed based on the calibrated value.

Operatian f'ﬂiﬂ[:r\_tLd SUCH

|
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4.4.1 Displaying an image in full window

Tap the [Full Screen| icon from Home.

The observation image is enlarged and displayed in full window of the display.
Tapping the button in the upper right of the screen displays back the window prior to the

enlargement.

¥
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4.4.2 Dlwdmg and displaying an observatlon image in different.
signal domains

{Flexible window function)
Arbitrary rectangular frames can be provided in the observation window to display images in the frames with

different signals.

1. Tapthe icon from Home and then the [Flexible View] icon.

A rectangular frame is displayed at the center of the main screen.
The photo data signals are named and displayed as “FXI.”

Draggmg the corner (Q) of the flexible window changes the frame size.
Dragglng the ms;de of the frame dlspiaces the frame. :

e
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2. Select a signal inside the rectangular frame to adjust the brightness.
Select the flexible window frame, and tap a signal of the photo data to select the signal.

Adjust the brightness of the image as desired. = See 3.8.5.

= See 3.8.1.

3. Terminate the flexible window display.

Tap the icon from Home and then the [Standard View icon.

%

.

In vision change operation, the click center functions only in the selection window.
SEl and REF images can be displayed when the secondary electron detector alone is mounted.
If no detector except a reflection electron detector (BED) is mounted, the BEI signal displayed when

switching is made to low vacuum (LV) mode is displayed in full window.




4.4.3 Displaying an image by mixing two signals

(Signal addition image)
Two arbitrary signals can be summed and the result can be displayed in the standard window.

1. Tapthe icon from Home and then the [Add Signals icon.

The signal addition window is displayed and an image resultant from signal addition is displayed in the

main window. _ _
The photo data signals are named and displayed as "ADD."

- R N

2. Select signals in the signal 1/2 window to adjust the brightness.
Select either Left or Right in the signal addition window (the illustration below shows a selection of

‘Right).
Tap and select signals of the photo data, and adjust the brightness. = See 3.8.1 and 3.8.5.




R

3. Adjust the mixing ratio of respective signais by using the slide button.
The mixing ratio is displayed in the upper middle of the slide bar and the adjustment result is reflected to

the main window.

Mixing ratio

Slide button

4. Terminate the signal addition display.

‘Tap the icon from Home and then the [Standard View icon.

Case of no detecfor othér than BED being mounted': |
When switching to the LV mode with signal addition being displayed, all three windows display

BE! signals and the signal addition display is terminated.




4.4.4 Displaying a histogram

The illuminance histogram of the observation image can be displayed.

1. Tapthe icon from Home.

The histogram of the cbservation image is displayed on the upper right of the main screen.
* Tapthe icon again to terminate the histogram display.




4.4.5 Adjusting digital images of the observation window

The following functions of image adjustment can be utilized with the digital image adjustment function:
(Gamma correction, digital contrast, digital brightness, binarization, illuminance inversion, and noise

mitigation)

1. Tap the [LUT] icon from Home.
The LUT correction window is displayed.

2. Select Image Processing of Image Lookup Table and conduct image adjustment.

Case of conducting gamma correction:
Drag the slide button and adjust the gamma correctron coefficient.

The adjusted coefficient is displayed in the upper middle of the slide bar.
The observation image is automatically gamma-corrected.
To'turn off the gamma correctlon tap the - Resef button.

value -



Case of conducting digital contrast correction:

Drag the slide button and adjust the contrast value.
The adjusted contrast value is displayed in the upper middie of the slide bar. The observation image is
automatically corrected with digital confrast. To turn off the digital contrast correction, tap the button,

ammm
* Correchion

Case of conducting digital brightness correction:
Drag the slide button and adjust the brightness value.
The adjusted brightness value is displayed in the upper middie of the slide bar. The observation image is

automatically corrected with digital brightness. To turn off the digital brightness correction, tap the

button. '

e



Case of conducting binarization:
Check Binarize.

The observation image is automatically binarized.
To tumn off the binarization, uncheck the check mark or tap the button.

&~

Case of conducting illuminance inversion:
Check Invert.

The illuminance of the observation image is automatically inversed.
To turn off the illuminance inversion, uncheck the check mark or tap the button.




Case of smoothing the image:
Check Smoothing. ,
The smoothing is automatically applied to the observation image.

To turn off the smoothing, uncheck the check mark or tap the button.

T e symee, B




4.4.6 Displaying an observation image in pseudo colors

The structural image can be emphasized by displaying it in colors.
For displaying an image in pseudo colors, operate the following windows and assign preferred colors to

respective illuminance gradations of the gray scale.

RGB color display
Hue displa Slide button Auto-color assignment
. | foon
iApply] icon

4.4.6.a Case of manually setting the color assignment

1. Tapthe icon from Home.
Thel Table window is displayed.

i

Hactron - Beam

nking




3. Drag the slide button located at the right of the hue display to select an illuminance gradation

subject to color assignment.
The following iliustrates the case of assigning colors for the illuminance gradation of 70 (0 to 255) on the

gray scale.
The RGB color display is all 70 because of the gray scale.

" Ieniagge Lookup Table

4. Adjust the mixing ratio of RGB to assign preferred colors.
in a similar manner, colors can be respectively assigned fo multiple gray scale illuminance gradations.

T T
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5. Upon completing the color assignment, the observation window is displayed in pseudo colors.

To terminate the pseudo color display, tap the button.

The illuminance gradation of the gray scale can be specified from the observation image by
using the illuminance extraction function. - o )
Tap the icon and specify the illuminance gradation of the gray scale from the
- observation img

The assignment of the prepared colors (customized colors) can be saved.
Tap the [Save] button to save as the assignment of customized colors.

To ppI the customized.

color assignment, tap the icon.




4.4.6.b Case of automatically setting color assignment

1. Tapthe icon and of tone correction.
The Image Lookup Tahie window is displayed. _

Beour - W
Blanking

2. Select Pseudo Color and tap the icon of the automatic color assignment.
A pseudo color image applied with the automatic color assignment is displayed.

To terminate the pseudo color display, tap the icon.




Using the report preparation software “SMile View” enables easy p_reparation of a report.
This section describes simple operation method of SMile View. For detailed information, see Chapter 8,

“Preparation of Reports.”

1. Tapthe iconi from Home.

The report preparation software SMile View starts and the image list window is displayed.

2. In the image list window, select File — Open on the menu bar.
The image file list in the folder where the specified file exists is displayed.

Index- image screen
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3. Tapthe button in the image list window:.
The layout sheet window is displayed.

Example) Case of selecting 3 images

o



5. Drag the image in the image list onto the layout sheet.
The image is pasted and the observation conditions are written next to the pasted image.

6. Print or save the report.

Print

a. Select File = Print on the menu bar of the layout sheet.

b. Tap the button in the print window. :
A report {image + observation conditions) is printed.

Save
a. Select File = Save as on the menu bar of the layout sheet.
4 b. Select one of the following as save format:

Layout File( * .lay) . Enables rewrite on the report.

JPEG(90dpi for Web) File (*.jpg) :  Entirely saves in the JPEG format equivalent to the image
: ' quality of 90 dpi.

Entirely saves in the bitmap format equivalent to the image

quality of 90 dpi.

BMP(90dpi) { % .bmp) :

c. Select a save destination and click the button.




4.6.1 User log-on and log-off

1. Tap the[User icon from Settings.
The User Management window is displayed. (The following illustrates the initial state.)




4.6.2 Adding a user

1. Tap the User icon from Setting.
The User Management window is displayed.

2. Tapthe button,
The user add window is displayed.

3. Enter a user name and select User Level.
4. Check Register Password, enter the password, and tap the jAdd - button.
Password registration depends on user's desire.
When a user having a registered password attempts log-on, entering the password is required.

A user icon can be registered from the button. - Set an image file used for the icon as

preferred.

button

Regarding user level
+ Standard user: Has no authority to add or delete a user. Also has no authority to execute editing users

except himself/herself.
« Administrator; A user having the authority to execute addition, editing and deletion of users

s

e e NN B




4.6.3 Editing users

1. Tapthe ican from Setting.
The User Management window is displayed.

2. Upon selecting a user desired to edit, tap the [Edi{ button.
The user edit window is displayed.

B i B )



4.6.4 Deleting users

1. Tapthe icon from Settings.
The User Management window is displayed.

EME AEDPRRTAYY o T



4.7.1 Changing the layout of the Ul window

4.7.1.a Case of transposing Right and Left of the navigator

1. Tapthe icon from Setting and then either of the [Lef] or icon.

pge Theme

2. The location of the navigator area switches.
The following illustrates the layout after selecting Left.

P STy BTSN, AMY



4,7.1.b Case of transposing Top and Bottom of the fixation icons

1. Tapthe icon from Setting and then either of the [Top| or [Bottorm| icon.

Image Mol

2. The location of the fixation icon switches.
The following illustrates the layout after selecting Top.




4.7.2 Changing the theme of Ul

1. Tapthe icon from Settings.

The Change Theme window is displayed.

2. Tap the desired color and then the [OK] button.
The Ul calor entirely changes.

F
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4.7.3 Setting the auto-function

4.7.3.a Setting links of the auto-function

1. Tapthe icon from Settings.
The Auto Settings window is displayed.

I AF Link - AS Link

Case of checking the checkbox =~ _ _ _
AF Link - ACB: Upon tapping the AR icon, ACB is also executed simultaneously.

AS Link — ACB/AF:  Upon tapping the [Ag] icon, ACB/AF is also-executed simultaneously.
Acc.V. Link - ACB/AF: Upon switching the acceleration voltage, ACB'IAF is simultaneously function.



4.7.3.b Setting the effectivity level of ACB

The effectivity level of contrast and brightness when executing ACB can be adjusted.

1. Tapthe icon from Settings.
The Auto Settings window is displayed.

2. Dragging corresponding slide button adjusts the contrast or brightness.
Both contrast and brightness are adjustable within the range of [-4 to +4].
Adjusted values are displayed in the upper middle of the slide bar.

Contrast adjustment: Using "+”4-and " results in the contrast being sharper and duller,
‘ _ respectively. o : ; -
Brightness adjustment:  Using “+" and “-" results in the brightness being brighter and darker,

respectively.

T



4.7.4 Setting the display for photo data
4.7.4.a Setting turn-on/off of photo data display items

1. Tap the [Photo Data) icon from Settings.

The Photo Data Settings window is displayed.

i

. MNavigator - .

2. Uncheck the check mark of the items not to be displayed.
Unchecked data is not simultaneously saved when saving images.

4.7.4.b Changing the character and background colors of photo data.

1. Tap the [Photo Dataj icon from Settings.

The Photo Data Settings window is displayed.

. 2. Tap the Background Color] and [Text Colot icons to select background and character colors.
The background and text colors selected are set.
icon:  The colors of “black” for background and “white” for text are set as default.

HighVac.



4.7.5 Editing photo data

4.7.5.a Editing the label

A text can be entered into the label field of photo data.

1. Tap Label Area of photo data. -
The Label window is displayed.

4.7.5.b Editing the photo number

1. Tap Photo Number Area of photo data.
The Number window is displayed.

g

W04 DM

2. Seta number.
button: Counts up.
E] button: Counts down.

button: Sets to “0000.”

|
j:
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4.7.5.c Setting the display of date

1. Tap Date Area of photo data.
The Date window is dispiayed.

Sequence of year, month and day
dd.MM.yyyy: 05.08,2013
MM.dd.yyyy: 08.05.2013
yyyy.MM.dd: 2013.08.05

Display of month
String: 2013.Aug.05
Math: 2013.08.05

2. Tapthe button in the logo setting window and select an image file.
Tapping the button delstes the logo image. _

logo image is displayed in photo data.

i - X
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4.7.6 Verifying photo data on the observation image

Photo data appended to the image data can be verified on Ul when saving the images.

1. Freeze the observation image. _ _
2. Tap the [Photo Data Verification| icon provided on the lower right of the observation image.

3. Photo data is displayed at the bottom of the observation image.
Not to display the data, tap the Photo Data Verification] icon again.

o e i |
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4.7.7 Constraining power consumption of the equipment

(Eco-mode function)
Power consumption is constrained when setting the system to standby status.
Manual and automatic methods are available for establishing standby status (the latter requires time setting).

4.7.7.a Manually establishing the standby status

1. Tap the [Ecd]icon from Settings.
The Eco Mode Settings window is displayed.

2. Tapthe |§w1tch to Eco Mode ammedlatelyl button.
The system changes to standby status-and the window for release is d|splayed

To release the standby status, tap the M button or conduct operation from the operation
panel Joystuck or the USB knob. : : .

-120min.

10rmin.

L Can

4.7.7.b Automaticaily setting the standby status through time setting

1. Tap the [Ecd icon from Settings.
2. Choose the Switch to Eco Mode after (10, 20, 30, 60, 120 or 180min.}.
3. Incase no operation is conducted for the set time, the system automatically changes to standby

status.




4.7.8 Switching the display language

1. Tapthe icon from Setting.

The Change Language window is displayed.

2. Select the [English| or (3758 icon, and tap the [OK button.

The display language on Ul changes.
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On the models JSM-IT300A and IT300LA, efficient EDS analysis is enabled by jointly using SEM software and
EDS software (as the analysis station). The following describes the EDS analysis method executable from GUI of

SEM:
For detailed information of the EDS analysis, see the operating manual of the EDS detector.
he following analyses listed in the table below are possible on this equipment:

e T Rpee e
Point analysis | Executes spectrum collection of point locations set on the image.

it

Line analysis | Executes spectrum coliection on the line set on the image.

Area analysis | Executes spectrum collection within the area (rectangular domain) set
on the image. '

Mapping Executes all elements mapping of the entire area of an observation
image. . . _

Successive Successively executes spectrumn collection of the locations reserved

analysis in the point and area analyses. o . L

BN
‘-.-"i o
8 Dwell Time
Sweep Count
RemainTime




4.8.1 Spot, line and area analysis

1. Tapthe icon from Home.

The Analysis window is displayed.

nalysis{ Transfer

Tap the Point or (Line| or jArea)) icon. |
Specify a location to be analyzed in the main window.
Upon specifying the location, the image is automatically brought in the analysis station and the analysis

starts.

w N

Multipte Analysis

Spectrum Analy:

4. Point {or line or area) analysis is executed and the spectrum analysis result is displayed.
The following shows the resuit of executing a point analysis.
For detailed information, see the operating manual of the EDS detector.
Upon compieting the analysis, SEM Ul accepts operation. Release the freeze to operate SEM.
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4.8.2 Whole area analysis

1. Tapthe icon from Home.

The Analysis window is displayed.

2. Tap the Whole] icon.

Th ' amaticail brought in the analysis station and the analysis starts.

3. The whole area analysis is executed and the spectrum analysis result is displayed.
Upon completing the analysis, SEM Ul accepts operation. Release the freeze to operate SEM.

For detailed information, see the operating manual of the EDS detector.



4.8.3 Mapping

All elements mapping of the entire observation image area is executed.

1. Tapthe icon from Home.

The Analysis window is displayed.

2. Tapthe icon. o
The image is automatically brought in the analysis station and the analysis starts.

Muftiple Analysis

3. Mapping starts and the analysis result is diSpIayed.
Upon completing the analysis, SEM Ul accepts operation. Release the freeze to operate SEM.
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4.8.4 Successive analysis

Spectrum collections at the reserved locations (point or area) subject to analysis are successively executed.

1. Tap the [Analysis| icon from Home.

The Analysis window is displayed.

3. Reserve locations to be analyzed for point or area analysis.
The reservation in combination of point and area is possible.
Upon setting the first reservation, a freeze image is brought in the analysis station.



4. Tapthe button in the analysis window.
Spectrum collection starts in the reserved order.
The marker is displayed in red before spectrum collection, yellow during the collection, and light blue at the
complete or hait of the collection.
For deleting the marker after completing the spectrum coliection, tap the
[Delete Reservation] button in the analysis window, or change the magnification or the stage location and

displace the vision by using the image shift.

© Muttiple Analysis
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4.8.5 Setting analysis conditions

The measurement condition window or the periodic chart window of the analysis station can be called up from

SEM U,
For detailed information of these windows, see the operating manual of the EDS detector.

»  Tapping the [Elemental Analysis| button displays the Periodic Table window.

+  Tapping the [Analysis Conditions| button displays the Acquisition Condition window.




4.8.6 Registering an analysis image

Register the image observed by SEM in the analysis station for using the vision when conducting an EDS analysis
in the analysis station, for example.

For anaiyzing methods after the registration, see the operating manual of the EDS detector.

1. Tap the Transfer Image] icon from Home

2. The image information during SEM observation is registered in the analysis station.

TR AT SRR,
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Arranged with the JSMHT300 logo and the [Min/Max./Close]

1 Title bar buttons. )
2 Menu bar Pull down (¥) , Home, Settings
3 lcon The icon array switches when switching Home and Settings.
4 Main screen D!splays the standard, multiple, flexible and signal mixing
windows.
5 Photo data Displays the present signal, acceleration voltage, working
distance, probe current, vacuum mode, magnification, etc.
6 Area for Label - No. date and logo | Enables text entry, and setting of No., date and logo.
Enables stage movement, snapshot image display and save,
7 Navigator area chamber scope image display, stage navigation operation,
etc.
Area for specimen holder Enables selection of a specimen holder and entry of a
8 selection and specimen height - specimen height.
entry '
9 Evacuation button Arrange_d with the VENT, EVAC, LV and LLC buttons and the
evacuation progress bar
10 | Coordinates display Displays the present coordinates of the stage.
11 | Fixation icon Arranged with the high-voltage ON/OFF icon, scan icon,
on icons auto-start icon, and manual control tools display icon.




5.2.1 Pulldown(V)

Tapping the ¥ mark displays the following pulldown menu:

@ Help

The help gufcle opens. The help guide includes the following items:
1. Simple operation Instrument start, specimen preparation, specimen replacement,

condition setting, observation, photographing and save, specimen
removal, and instrument termination .
2. Microscope adjustment Filament replacement and filament adjustment

@ System Information _
Displays the software version and serial number (S/N).

Yes Terminates the application and closes UL
Ne Does not terminate the application and displays Ul.
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5.2.2 Home

Image management

Open : Open the image file.
Save : Saves an image (In the case of Auto save being turned off).
Copy : Registers an image on the clipboard.

Report : Starts the report preparation software (Smile View).

2 | View

Mode : Enables changing to the standard, multiple, flexible or signal mixing

window.
Full Screen : Enables an image to be displayed in the whole area of the monitor.

3 | Adjustment

Electron Gun : Displays the window for heating the filament or adjusting the

electron beam axis.
Beam Blanking : Executes beam blanking to mitigate specimen damage.

Wobbler : Executes wobbler and adjusts the location of movable aperture.
Recipes : Displays the window for seiting the most suitable observation
conditions based on the specimen category.

4 | Tools

Histogram : Displays the brightness and contrast of an image in a histogram.
LUT : Displays the window for digital adjustment or pseudo-color dispiay of an
image.

3D Imaging : Displays the window for preparing an anaglyph image or 3D
measurement image.

Movie : Saves a moving image.

5 | Measurement

Ruler : Displays the window for measuring a distance between two points, area,

efc.
PCD : Measures an irradiation current by using the probe current detector

(effective when mounting the option).

6 | Tilt Correction

Tilt Mag : Displays the window for matching the magnification in the upper and
lower portions of the observation vision with a specimen being tilted.

Dynamic Focus : Displays the window for correcting the focus such that all
surfaces of a specimen are in focus with the specimen being tilted.

7 | Analysis
(effective with the A
/LA model)

Analysis : Displays the window for analyzing elements by using energy

dispersive X-ray spectrometer (EDS).
Transfer image : Transfers an image of the analysis vision to the analysis

station.



5.2,.3 Settings

TP

Displays the window for logging of or switching the user.

1 | User

2 | Environment Language : Displays the window for setting the language. .
Theme : Displays the window for setting window design {color for SEM Ul).

3 | Layout Navigator : Enables the arrangement of the navigator area to be changed,
Icons : Enables the arrangement of the fixed icons to be changed.

4 | Save Image : Displays the window for setting the image format or auto-save destination
when saving an image. ‘
Movie : Displays the window for setting the image quality or save destination when
saving a movie.
Photo Data : Displays the window for setfing the image guality or save destination
when saving a movie.

5 | Options Electron Gun : Displays the window for heating the filament or adjusting the axis of

electron beam.
Scan : Displays the window for sefting the scan speed and photo mode.

AutoDisplays the window for setting the auto-interlock function and adjusting ACB.
Stage : Displays the window for sefting the stage movement method and
movement limit.

Eco : Displays the window for setting power saving during standby.

Vacuum Displays the window for setting slow leak.
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Add signal
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The present observation conditions are displayed.

Tapping the A marks below the respective photo data displays various windows, thereby enabling change of
the observation conditions.

y J._H':'_D Advanced

A0.0mim -
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Signal

Enables switching of the signal.

Acceleration voltage

Enables switching of the acceleration voltage.

WD

Sets a focus current for selected WD.

Probe Current

Enables switching of the irradiation current.

Pressure

Enabies switching of the vacuum mode and setting of a pressure

G O] B | N —

Magnification

Enables switching of the magnification.
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Label

' 'Enables label inscription.

1,,
2 | Number Enables setting of data number
3_ Date - Enables setting of date

4 | Logo Enables pasting of logo.
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Page advance button

Slide
{Graphic display
scaling) button

1 | Stage Enables operation associated with stage movement.

2 | Snap Shot Enables simple saving of live images.

3 | Stage  movement | Enables movement of the stage along the X, Y or R-axis, and smu!taneously along the

‘[ button X and Y-axes.
4 | Specimen holder | Graphically displays the specimen holder in selection The sllde button on the upper
graphic display right enables scaling.
- - Checking Display TZ reflects the degree of tilt viewing from top on to the graphic when

: operating the T and Z-axes.

5 '| Memery Tapping [Memory button enables registration of the present coordinates and movement
to the registered coordinates.

|:

6 | Last Move ppmg"his button after moving the stage restores the coordinates immediately before

the movement.




< Switching between stage screens >
Swipping® the area other than the stage movement button within the graphic enables switching of the screens

of viewing the specimen holder from top and lateral directions, the stage navigation screen, and the chamber
scope screen. Switching the screens is aiso possible by tapping the page advance button.

T and Z-axes movement screen

Software version before Ver 1.16

¥ Stage navigation screen

Software version Ver 1.16 onward, : S .
scale the chamber scope image. Ver 1.16 onward

% Chamber scope screen

% The stage navigation system and the chamber scope (both are optional) are required.

L

1

Swipe means to slide the fingertip while pressing the screen.
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5.7.2 Snap Shot

Six screen mode

T Image béste érea“ Tappmg thé snap 'icoh' @w:th the livéubr”f'ré‘eie ir"h'ag'e being displayed enables
pasting of the image in this area.

Icon for opening a | Tapping this icon enables calling-up of an image stored in the predetermlned folder and

.

file ' pasting thereof in the image paste area .
3 | Snapicon Icon for. paSting an Image inthe area @.
4 | Condition | For reproducing the conditions when an image was. pasted, tap this icon to display the

reproduction icon | photo data window, check the COﬂdltIOl’]S desired to reproduce in said wmdow and then
tap the [Apply button,




Single screen mode

'Né'\)igé'tidh i'rha'gle

' If 'y'-o'u e'rif‘:idﬁs'é fh éi’éé wh|chwantto nlaféé by fhié frénﬁe in th‘i's i‘m’agé, t‘h‘e stag'e”

moves so that the center of area becomes center of the main screen. The
magnification is enlarged depending on the frame size.

Tapping this icon enables calling-up of an |mage stored in the predetermmed folder

2 | lcon for opening a
file and pasting thereof in the image paste area (.
3 | Snapicon Icon for pasting an image in the area (D.
4 | Condition For reproducing the conditions when an image was pasted, tap this icon to display
reproduction icon | the photo data window, check the conditions desired to reproduce in said window,
and then tap the [Apply button.
5 | icon for saving a | Tapping this icon enables storing a shap image into the arbitrary location. An area

image

frame is also stored at the same time.
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)

Enables switching of the evacuation and vacuum mades of the specimen chamber and verification of
evacuation progress. ' ' '

VENT Sets the specimen chamber and EOS to VENT (state at the atmospheric
pressure). '
EVAC Evacuate the specimen chamber and EOS.
LV Enables switching of the vacuum mode.
LLc? Evacuates the load lock chamber.
Table 1

Bl Evacustion process
WAIT (state at the atmospheric pressure)
PRE EVAC (start of rough pumping)
PRE EVAC = EVAC (start of main pumping)
EVAC (during main pumping)

READY (state of image observation enabled)

? Effective when the Load Lock Chamber (option) is equipped.
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The present coordinates are displayed, and tapping one of the items enables operation of the stage by

specifying the coordinates
(* excluding SRT display)

Tapping the SRT displays the manua

of the image.

I adjustment tool as shown on the next pate, thereby enabling rotation

Observation icon

Used when observing an image.

RDC icon

Limits the electron beam scan range.

pixels)

* Screen resolufion

(320% 240

Fast icon

Displays a live image at high speed.

Slow icon

Displays a live image at slow speed.

Freeze icon

Makes a live image to a static image.

Photo icon

Starts imaging.

CF icon

Mitigates charge-up® of the s_becimen.

AF icon

Automatically adjusts the focus.of an image.

AS icon

Automatically corrects the astigmatism of an image.

Automatically adjusts the brightness of an image.

ACB icon

A OOI~N| Do B w N =

— =2

Manual icon

Used for manually adjusting the obsarvation conditions.
Tapping this icon displays the manual adjustment tool shown on the next

page.

* A phenomena in which the observed images have uneven brightness or shifting of the field of view during the scan due to electric charges

building up on the specimen.
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Manual adiustment tocl

Used for focus adjustment of an image.

1 i Focus
2 | Stigma Used for astigmatism correction of an image
3 | Brightness Used for brightness adjustment of an image.
4 | Beam Shift Used for movement the field of view at high magnification
5 [ SRT Used for image rotation.
8 | Suppress Used for rough adjustment of the brightness of a backscattered electron image.
7 | Center display In the Focus(D, the working distance is displayed.
The indicator is displayed in the Stigma®, Brightness@, and Beam Shift®.
The angle is displayed in SRT®).
8 Adjustment button | The button display switches according to the selection of respective adjustment
ites, and the selected item can be adjusted.
9 | Reset button Displayed when selecting the Focus®, Stigma®, and Beam Shift@.

Tapping the button displays the reset message, and tapping Yes button resets
the eguipment to the shipment state.

10

Close butfon

Close the manual adjustment tool.
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< Report creation software (SMile View) >
SMile View is software for disptaying the index image of scanning electron microscope {SEM) image data on

the personal computer for easy layout and printing.
The SEM image data consist of SEM image files in BMP format and text files that contain observation
conditions. This software links these observation conditions to image files, enabling you to display an index

image that contains SEM images with observation-condition data on a folder-by-folder basis.

You can edit the displayed SEM image on the layout sheet, and print it at the same size as a photograph.

Also, new features enable directory display and data transfer to Microsoft Word files.
(Since the PC and Microsoft Word are not included in this software, please prepare these separately)

< Applicable image formats >
Bitmayp (BMP) format, JPEG format, uncompressed TIFF format, extended metafile format

< Functions >
Index-image disptay, magnified image display, label, memo, index print, layout sheet, layout batch print,

layout-sheet saving, ACB (automatic contrast/brightness adjustment), image-capturing tool, easy distance
measurement (vertical distance, horizontal distance, distance between two arbitrary points, average profile

display), two kinds of image filtering, transfer to Word, directory display, search



1. Insert the floppy disk into the personal computer, and then double-tap to start Install.exe.
The below window is displayed appears.

2. Specify an installation folder, and tap the button.
The default is C:\Program Files\jeol\smv.
When the installation (decompression) is completed, the setup window is displayed.

3. Put a check next to The short cut of SMile View is made.
4. In “Standard Photo Size", select 128X96mm .

5. Enter the password.
As the password, type JEOL USEROCDQOC in uppercase letters.

6. Tapthe button.

After the message, “Setup completed” appears, tap on @ button.
The above procedure compietes the installation. Start SMile View from the desktop shortcut.
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This chapter introduces basic procedures for operating SMile View.

6.3.1 Start the Smile View

1. Tapthe icon from Home.

The report creation software SMile View starts.

Copy; Reptt

6.3.2 Displaying Index Ima

With SMile View, you can open the index-image screen by using one of the two methods to show the SEM

image.

6.3.3 Opening by using File menu

1. After starting SMile View, select the
This displays the Open window.

2. Select the folder in which SEM imag

Open command from the File menu.

es are stored from the Look in box in the Open window.

3. Select the file name of the SEM ima%e that you want to see from the image-file index displayed

under the Look in box, and click the
All of the images contained in the folder

Safplez;Smp
=3 sample3.bmp

Openf button.
are displayed.
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6.3.4 Opening by drag and drop

1. Drag a folder in which SEM images are stored, a SEM image file, or a text file attached to the

SEM images.
2. Drop it into the SMile View shortcut icon, or into the window of the index-image screen after

opening SMile View. -
Al of the images contained in the folder are displayed.

6.3.5 Pasting SEM Image on Layout Sheet

Drag and drop a scaled-down SEM image in the index-image screen into the layout sheet. This pastes the
scaled-down SEM image of the same size as the photograph on the layout sheet.

@ Drag and drop a scaled-down SEM image in the index-image screen into the layout sheet.

At the same time, the observation conditions and label aftached to the SEM image are pasted to it.
When you change to another SEM image, the observation conditions and label are changed to those
attached to new SEM image, since observation conditions and labels are linked with the SEM image.
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When you have set up the layout of such things as the image area and the text area by using the Setup

menu, you can paste an image on the same area at any time.
The layout of such things as the image area and the text area set up by using Setup can be freely

changed in its position and size by using the button.

A e T

Ex.) Setup of Layout (two images)




6.3.6 Opening Layout Sheet

The layout sheet saved on the hard disk can be opened by using one of the following three methods.

Click Open in the File menu to open the Open window. Specify the folder name and file name that you

want to open, and then click the Open butfon.
*  Drag and drop the file with extension .Lay directly into the layout sheet. _
Drag and drop the file with extension .Lay directly into the SMile View icon. This creates a new layout

sheet.

6.3.7 Saving Layout Sheet

When finished with the layout of items such as SEM images, observation conditions and text on a layout
sheet, you can save the layout sheet on the hard disk.

Layout sheets are saved by default in the same folder in which the SEM image displayed on the index-image

screen is saved.

1. Tap Save as in the File menu.
2. Type the file name that you want, and then click the button.

Layout sheets are saved with the extension .lay.
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6.3.8 Printing Layout Sheet

You can carry out batch printing of the displayed layout sheet and of other layout sheets saved in the same
folder as the displayed layout sheet.

6.3.8.2 Printing of displayed layout sheet

Here is the procedure for printing the displayed layout sheet.

1. Select Print from the File menu, or tap the button on the toolbar.
The print window is displayed.

2. Tapthe button,

6.3.8.b Batch printing of layout sheets

1. Tap Batch layout print from the File menu.
The Batch layout print window is displayed.

2. You can carry out batch printing of the tayout sheets saved in the specified folder.
For details on how to perform batch printing, refer to “Batch layout print” in Section 6.6.1.a.
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This chapter introduces advanced procedures for operating SMile View.

6.4.1 User’s Layout

With user's layout, such areas as image and fext areas can be freely set and the company’s logo or other

graphics can be added.

1. Decide on the image area, fext and other areas that you want to set.

2. Click Save User’s layout from the File menu.

3. Keyin a layout name, and tap the button.
User’s layouts are saved by default in the same folder in which the SMile View program is saved (C:\

Program Files\jeol\smv). User's layouts are also saved with the extension .Lay.

6.4.1.a Make the layout seat where two or more photographs can be
displayed

1. Make the image frame.
The mouse pointer is changed when you tap the |SEM image frame] button. And then click the image

frame you want to display.
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2. Adjust the image frame size

Select the image frame that changes the size by tapping . button. And three square marks appears

at the right side, the under side, and the lower right of the image frame. With dragging the mark of the
lower right, the frame size, with the aspect ratio maintained, can be changed.

You can adjust it accurately by using the photograph magnification as a standard when the size is

decided.

Drag the SEM image to the image frame and drop to it. Then, the photograph magnification is displayed
with the image. The photograph size can be decided accurately by adjusting the size while gazing the
photograph magnification. This image remains until time when the layout is preserved, however,

opening as a user layout, only the image frame is displayed.

- SM-TEODF
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The size of the image changes to 1/4 (The magnification becomes 1/2}
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3. Duplicate the image frame.
Touch&hold in the image frame and select Duplicate. Make the duplicate of arbitrary number.

Duplicate

When the duplicate is made, the label and the text frame are also copied. If the label and the text frame
are unnecessary, you can delete them by touch&hold.

4. Save the layout.
Save the layout according to above method.
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6.4.1.b Creating a layout sheet with a company’s logo

Capture the logo in the BMP format by using a scanner, for example.

After deciding on the layout of such things as the image area, paste the logo mark on the Iayout
sheet, and then adjust the size and position of the logo mark.

Touch&hold the logo mark, and check Keep image from the touch&hold menu that appears.

Save the layout sheet with the company’s logo as a user's layout.

o N

6.4.2 Operations in Layout Sheet

In the layout sheet, piacing the mouse pointer over objects, such as an image and text area, and pressé&tap
or touch&hold (clicking the right mouse button) displays various menus. These menus show functions that
you can use for the selected object such as an image or text. :

6.4.2.a Functions available by right-clicking image area

Perform the Press&tap (Touch&hold) in the image area, the menu shown below is dispiayed.

Copy to Clipboard
Copies the image to the clipboard.

Paste (Metafile)

Pastes the metafile image from the clipboard to the layout sheet.

Paste (BMP)

Pastes the bitmap image from the clipboard to the layout sheet.

To Word
Adds the selected image and its text data to a Word file.

Save as
Saves the image. You can select bitmap or JPEG as the file format.
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Image Setup
Selecting Image Setup opens the image setup panel (Fig-30). With the image setup panel, you can set the

size of the image frame, and adjust the contrast and brightness of the image.
You can change the image frame size by pressing the $TD size, Original, or 1/2 size button.

Alternatively, you can set it to any size by entering numbers.

Also, by putting a checkmark to Keep aspect ratio, you can keep the image aspect ratio constant even if
you change the image frame size. Canceling Keep aspeect ratio fits the image shape fo the image size frame,
irrespective of the aspect ratio. After changing the image frame size, clicking Save STD Size changes the

image frame size to be used for pasting images onto the layout sheet.
If the standard size and the original size™" are different, the photographs are enlarged or reduced according

fo the frame; you cannot print them in the original photography size.

You can change the conirast and brightness of the image by dragging their sliders. ECC enhancement
enables you to increase the contrast of an image that contains extremely bright (or dark) regions, without
saturating the brightness. You can compare the before and after images in the image setup panel.

 The standard size is the frarme size to be displayed in the layout sheet. On the other hand, the original size is the size of the photographs

stored in the bitmap images; it might vary depending on tha modsl or mode.
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 With only contrast and brightness adjustment

With ECC enhancement

You can increase
the contrast
without saturating
the brightness.



Smoothing
Filtering set with Auto function Setup of the Tool menu is carried out by using Smoothing. An image with

noise can be smoothed for observation. (Smoothing applies only to gray-scale images. It does not apply to a
copied image that is a colored image.)

Smoothing

Sharpensr _
A sharper image can be obtained by emphasizing the amount of change in the image using Sharpener.

(Sharpener applies only to gray-scale images. It does not apply o a copied image that is a colored image.)

Sharpener

Mgasure
You can measure the distance between two points on the SEM image of a layout sheet. For details, see

Section 6.3, "Measurement Function.” Measure appiiés only to SEM images with text information.

Zoom
Enlarges the image.

Position Adjust
Adjusts the position of the image frame, balancing it with image and text frames {o its left and above it. This

does not work if other frames are some distance away.



Draw Scale
Draws a scale at the fower right of the image. A scale is automatically indicated according to the photograph

magnification.

Frame
Surrounds an image with a frame, when Frame is selected.

Keep imageg
When this command is selected, the user's layout is saved together with its image data and iayout. To save

the logo after layout, keep this command selected.

To Front .
Shows a desired image frame on the top of the display, when more than one frame is opened. However, the

text frame appears always on the top of the display.

Duplicate .
Makes a duplicate of a desired image in the layout sheet. The duplicate is displayed at the same size as the

original. You can make up to eight duplicates at a time.

Make linked Labei :
Makes a label linked with an image frame. However, when a labeli linked with the image frame already exists,

the warning message “Linked label already exists” appears, and you cannot create a new label.

Make linked Text | |
Makes a text frame linked with an image frame. However, when a text linked with the image frame already

exists, the warning message "Linked text already exists” appears, and you cannot create a new text area.

Delete
Deletes an image from the image area. However, the label and text that are linked with the image cannot be

deleted.



6.4.2.b Functions available by right-clicking text area

When you pressé&tap (touch&hold) the text area, a menu appears as shown in Fig-34. The explanations of

the functions are given below.

[escriptio

To c;ut text, éeléct thé"-téxtﬂ region by dragglng the =rnousev.-i ovér it while holding down

Cut the left mouse button; then, click Cut.

Copy Copies the selected text region, and then saves it on the clipboard.

Paste Pastes the text saved on the clipboard in the text area.

Delete Deletes the text area. ' .

- ; Adjusts the position of the text frame, balancing it with image and text frames {o ifs

Position Adjust left and above it

Font Specifies parameters such as the type and size of the font in the text arsa.
Displays the contents of the SEM image observation-condition file that
corresponds to the SEM image file, just as they are. Select this item before

No filt dragging an image from the index-image screen. If this item is not checked, the text

use fitter fiiter feature is enabled. '

% Even if the No use filter command is not selected, the functions of the text filter
do not work when Auto function Setup of the Tool menu is not selected.
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6.4.2.c Functions available by right-clicking on label

When you press&tap (touch&hold) on the label, a menu appears as shown in Fig-35. The explanations of the

functions are given below.

Copy

Paste Pastes the text saved on the clipboard in the text area.

Text editor Opens the Text Editor dialog box (Fig-24) for editing the label.

To Front Brings the selected label to the foreground, if the Iabell and image are overlapped.
However, the label appears always on the top of the dispiay.

Delete Deletes the text area. -

Position Adjust g?tjtéitg ;hb% egsi.tijcion of the text frame, balancing it with image and text frames to its

Font Specifies parameters such as the type and size of the font in the text area.

Alignment Centers the text in the label. Removing a check aligns text {o the left.

Select Back Chariges the background of the label to white or transparent.



6.4.2.d Functions available by right-clicking blank space

When you press&tap (touch&hold) the biank space outside the image area, text area and labels on the
layout sheet, a menu appears as shown below.

Pastes the metafile image at the standard photograph size. Click Paste (Metafile)

4 to show a box with a blue dashed line corresponding o the image size. Determine
Paste (Metafile) the position of an image by using the mouse, and then right-click the image to
finalize its position. This item is available only when a metafile image is stored on
the cliphoard. _

Pastes the bitmap image at the standard photograph size. The operation is the
Paste (BMP) same as that of Paste (Metafile). This item is available only when a bitmap image is
stored on the clipboard. '

This item is available with text in the clipboard. Clicking Paste (Text) displays a
Paste (Text) blue-dashed box that represents the fext area. After determining the position using
the mouse, a ciick shows the {ext.

Sets whether the margin is indicated or not. The margin is the area that cannot be
printed. When Show margin is selected, the area that cannot be printed is indicated
in green. Areas other than the margin can be printed.

Show margin
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6.4.3 Measurement Function

6.4.3.a Measurement screen

Select the Measure command from the menu that appears when you press&tap (touch&hold) on the image
of the layout sheet. The screen changes to the one shown below.

Measurement .
value Measurament modes Measurement line Entarged view of
Nurmbar of (horizontal, vertical, width selectors cursor position
u !
two points) ' Average profile display button

measurements ——-\

The results of measurement are written on the photograph. The average, standard deviation, and other
values resulting from measurements at several points are also calculated.

After selecting a measurement mode. drag from the initial point to the final point to measure.
The initial point is the location of the mouse cursor when you press and hold down the left button of the

mouse, and the final point is that when you release the button. The distance between the two points s

displayed.

The unit of measurement is the unit displayed befow the micron scale on the photograph.
The result of measurement is immediately indicated black numbers on a yeflow background. Drag it to any
desired position. To redo measurement, select Delete from the press&tap (touch&hold) menu or tap the

button at the upper left corner of the screen.




6.4.3.b Magnification correction

Magnification correction is possible for better distance measurement. When measurement value is in green,
it shows the result of measurement based upon the magnification of photograph. When it is in yellow, it

shows the result after measurement correction.

. Measure the distance between two points as a standard vaiue.
2. Key the standard value into the measurement value indication box, and then tap the [Calibration

—

button. ‘ :
The numbers change from green to yellow, and also the result indicated with white numbers on yellow is

replaced by the standard value on the image screen.

Measurement value indication

3. Measure a distance that you want.
4. Click the [Off button of the screen to turn off the measurement correction. -

The numbers change to green.
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6.4.3.c Average profile display

Clicking the 1 button displays the average profile display menu and a green frame.

Tapping the @ button graphs the vertically averaged contrast in the green frame.
Dragging the square M of the frame changes the region for averaging.

Off button OK btton utton
Calibration button '

Layer image View
Displays the green-framed image as the averaged grayscale image.

Auto Scale
If Auto Scale has a checkmark, the maximum and minimum values of the average graph reach the upper

and lower limits of the frame.
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Data to Clipboard checkbaox
Statistics to Clipboard checkbox

6.4.3.d Data to Clipboard and Statistics to CIipb'oard check boxes

Measurement results can be copied to the clipboard, after terminating the ‘measurement mode. If you require
all measurement values, select the check box next to Data to Clipboard. If you require statistics such as the
mean, select the check box next to Statistics to Clipboard. When both check boxes are selected, perform
measurements and tap the button to terminate the measurement mode. The following data are exampies

saved as text.

Mean value = 502.7

Standard deviation = 379.8 Statistiecal
Nurﬁber of measurement points

= 3

Unit <nm>

331 : Measured

938

The contents of the clipboard can be used for statistical treatment or graphing by pasting the contents to the
text frame on the layout sheet, or to spreadsheet software.

When the measurement mode is terminated, such results as measurement data and statistics data, other
than those on the clipboard, are cleared. However, arrows and measurement values on the image screen
remain on the image screen, because they are written as images. : o _
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6.4.4 Converting SEM Photographs into Electronic Form
and JPEG Images into HTML Documents

6.4.4.a Converting layout sheets into images for attaching to E-mail

When saving the layout sheet, you can save it as a JPEG image in addition fo saving it in the standard

format.

1. Select Save és from the File menu on the layout sheet. -
2. Select JPEG in the Save as type box. After that, key in a file name and then tap the

button.
The layout sheet is saved as a JPEG image with data compression after making the layout sheet size

appropriate for viewing on the screen of the PC, and so the final size of the file is about 200kB.

Some image information is lost with JPEG data compression, and it cannot be recovered. If you want to
save data without loss of information, save it in .lay format.



6.4.4.h Converting layout sheets into HTML document

By converting layout sheets into HTML format, you can display an index image on a personal computer on
which SMile View is not installed. Most of the recent computers can display HTML documents, as browsers

such as Internet Explorer and Netscape can open them.
For this conversion, first select HTML Index from the Tool menu. To load the layout files into an HTML

document, the software converts them info JPEG images. Therefore, SMile View can convert an index image
that contains JPEG images into an HTML document.

1. Select JPEG or Layout as the format of the files you want to convert.

Files in the sefected format appear in the File selector box. If you select Layout, then select 90 or

150dpi as the resolution for JPEG conversion.

2. Select layout files (JPEG images) in the File selector box.
To select all the files, tap [Select all button. To deselect the files, click [Cancel

3. Click the [Make Index button.

This creates files with the extensions Index.htm and File.htm, and files with the extension .idx for each
image, in the folder that contains the layout files. At this time, if Make Holder has a check, the software

creates a new folder named HTML.

4. Load the Index.htm file into an Internet browser.
The index image of the layout sheet appears. Clicking on a small image enlarges it, enabling you to

check details.

All the files saved in the new folder are required in order to dispiay the images of the layout sheet.
When copying all of the files, it is recommended to copy the folder that contains them alf at one time.




6.4.5 Auto Function

One of the features of SMile View is auto function, which enables you to lay out an image simply by pasting
the image on the layout sheet, supported by the several functions of the auto function.

To set up the auto function, select Auto function Setup from the Tool menu of the layout sheet.

The auto function is as follows:
+  Automatic contrast and brightness adjustment (ACB function: Only available for grayscale images; not

available for copied images.)
This automatically adjusts the contrast and brightness of the SEM image.

¢ Image filtering (Smoothing: Only available for grayscale images, not available for copied images.)
The roughness of an image is diminished by filtering, so you can see a better image.

=  Micron-scale writing (Available only for images with text indication of SEM image observation

conditions)

o Textfilter -
You can edit the text of SEM image observation conditions for a better appearance.

.
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6.4.5.a Auto Function Setup Dialog

Ageel, Volt i
Org, Ma}j, X
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Image:

<SEl»
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M, SIGNAL COME<COMBOSITIONS

< Text filter >

Use Text filter
Allows you to convert keywords, which are contained in the text of SEM image observation conditions,

to common expressions, which are the character strings displayed in the “Words to be printed” column
~and their following character strings up fo the end.

The @ mark of Photo Mag. x@ in the "Words to be printed”
With this @ mark, magnification correction is carried out, taking into account the size of the space

for pasting the photograph, when magnification data are rewritten. Furthermore, numerical data
are converted to integers, and when items other than magnification, such as accelerating voltage,
are selected, conversion fo integer format is carried out.

»  The text filter does not work with text containing the slash (/) in the “Words in text file” column. To
use the filter on text file that starts with a slash in the Words in text file column, first remove the

siash.

Save
Saves the contents of the text filter that is used when opening SMile View. The contents of the text j

filter are saved in the layout sheet, and they are used with higher priority.

Font

Selects the typeface to be used in the text filter.

-
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<ACB>

Auto checkbox
When the command is selected, the automatic contrast and brightness adjustment (ACB) function

works in the same way as ACB selection on the layout sheet.

Brightness _
Enables you to select Dark, Standard or Bright during operation of automatic contrast and brightness

adjustment.

<Image filter>>

Auto
When Auto is selected, the smoothing filter previously set operates. You can select between two

smoothing levels.

< Photo >

Scale _
If there is a text frame linked with the image, a micron scale is written on photograph image, according

to the magnification information in the text frame.

Mask
When this is selected, one line of space under the image can be covered with a white mask.

Frame
When an image (other than a metafile image) is pasted on the layout sheet, the image is framed.

<Date Print>
When the layout sheet is pasted, the date is printed at the left bottom with this function.
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6.4.6 Useful Hints for Use

6.4.6.a Saving layouts for frequent use on the desktop

A layout sheet file with the extenslon .Lay can be opened by dropping it on the layout sheet, and so it is
recommended fo place the layout file on the desktop for easy opening by dragging and dropping it.

6.4.6.b . Putting characters and arrows into photograph

The labels of the layout sheef can be also shown on a photograph. Right-click on the label to open the menu,

and then select Select Back. _
To draw marks such as arrows, select Symbol from the Tool menu to open the Symbel dialog box.
The symbols in the dialog box can be pasted on the layout sheet by dragging and dropping them.

Since they are extension metafile images, their size can be changed like other images.

6.4.6.c Adding symbels you created

By saving image files (such as metafiles and bitmaps) in the folder named PARTS in the folder C:\Program
Files\jeol\smv, which contains the SMile View application, you can use them as symbols in the layout-sheet
window. It might be convenient fo create your company logo.
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SMile View has basic screens such as an index-image screen, a magnified-image screen and a layout-sheet
screen. This chapter explains the basic SMile View screens.

+ The SEM images stored in a specified folder are shown scaled down in an index-image screen. The

scaled-down SEM images maintain good quality as SEM images.
»  You can display up to 50 scaled-down images at a time. If the folder contains 51 or more image files, the

button appears.

«  Every image is accompanied by a label in which you can put a comment. All the labels can be stored as

Label. txt files in the same folder as the image data.
» Tapping a scaled-down SEM image in the index-image screen selects the image; the frame of the

image changes to blue. If you click the selected image again, the frame returns to gray and the image is

deselected.
+  Clicking the button while a scaled-down SEM image is selected, or double-clicking the

scaled-down SEM image, shows the scaled-up im'age on the display. For information on image
entargement, refer to 6.3.4, "Magnified Image Screen.”

Menu bar
Toolbar

Scaled-down

Directory display <
SEM images

| abel

Image information <

The index-image screen has a menu bar, toolbar, and directory display. The following are explanations of

their functions.



6.5.1 Menu bar

6.5.1.a File menu

TIPHIC
Shows the SEM images in the speci’r“ ied folder. At the same time, an index folder is

Ope'h“ ne
made in the specified folder. Tha scafed-down SEM image data are stored in the index
foider.

Update Overwrites the SEM |mage stored in the speclf:ed folder and displays the updated
image.

Save Labels Saves the labels you changed. By default, the filename of a SEM image is used as its
label; you can change a label to the specimen name or anything you want.

-Saving labels creates a Label. txt file in the same folder that contains the images.
Changing labels, however, does not change the filenames of the SEM images (labels
are saved automatically).

Remake When you have changed the number of colors in the display, selectmg Remake index

index image image remakes the scaled-down SEM image data.

Exceptional If you save a printer setting with Bitmap print mode selected, printing data using that

Printer: printer creates and prints the BMP image of the overall layout. With normal settings, if
some parts are not printed or other problems occur, set up each printer.

RICOH imagig Neg 453 RPCS

Printer Setup Changes printer settings such as paper size and page layout.

Layout Sheet Opens the layout sheet screen for layout editing.

Index Print Performs the index printing of the scaled-down SEM images in the index-image screen.

Bateh Print Performs continuous printing of the specified SEM images in the index-image screen.

i

To select multiple images, click on them while holding down the or i key.

With the layout sheet set up, the selected images are printed according to that layout.
Simultaneously, the labels and text data of the images are also printed according to the
layout.

In the below figure, the nine image files selected (and framed in blue) in the
index-image screen are printed, three imagss at a time, according to the fayout.

If the layout sheet is not set up, the specified SEM images are printed at the largest

" size possible for the paper size, at the given aspect ratio (the paper direction is

changed automatically).
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Set up thelayout in advance.
BRI || e T g

Save
Window
Position

Saves the window positicns of the index-image screen and layout sheet on the display.

Reset
Position

Initializes the position data stored using Save Window Position. The initialized
window positions take effect at the next startup.

Exit

Terminates SMile View.

6.5.1.b Edit menu

' Copy

Copies the selected image from the 'inde'x-image screen to the
clipboard.

Change it into the gray scale | Converts the selected color image into grayscale, creating a new bitmap

image

image in the folder.

Select all

Selects all the SEM images displayed in the index-image screen.
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6.5.1.c Selector menu

Use a keyword to narrow down the SEM image files to be displayed in the index-image screen. For example,
to select filenames that end in “a,” tap the LLast characters (STRING)| button, and then change STRING in the
input box to “a” (or enter “*a” directly); as a resuit, only SEM image files whose filenames end in “a" appear in

the index-image screen (the asterisk * denotes any character string).

6.5.1.d Search menu

1 MED images\FE-SEMILOG.THT
{IMACE - climagesiFE-SEMHTMLItesH Jpg

Entering a keyword and tapping the button starts searching for the files that contain the keyword. To
narrow the search range, enter the folder location directly or select it using the button.
Select Folder/image file Name, Label, Memo, or Text to specify where to search for the keyword (multipfe

selection possible).
The results of the search appear in the blank field below. If you click on a result, the index-image screen

displays all the images in the foider that contains the selected image.
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6.5.1.e Display menu

L size, S size Changes the image size in the index-image screen. Selecting L size
displays images with 138 x 138 pixels, whereas selecting S size
displays images with 80 x 80 pixels.

Data text Putting a checkmark to this item enables the directory-display feature.

English, Japanese

You can select English or Japanese for display language.
3% On English version Windows, you cannot select Japanese.



6.5.2 Toolbar

Update : Is the same feature as Update in the File menu.
Memo Tap the Memd button to open the Memo dialog box. Memo is the

function that records comments on the folder containing SEM images.
Tapping the button or exiting the application saves the recorded
memo as a text file (Log. txt) in the same folder that contains the SEM
images. If you write in the memo items in common pertaining to images
contained in the folder, you can use them as keywords when retrieving

the images. |
Magnifies and displays the selected scaled-down SEM image

Zoom

Layout Is the same feature as Layout Sheet in the File menu.

Print |s the same feature as Batch Print in the File menu.

Large Changes the size of scaled-down SEM image. When Large is checked,

the scaled-down SEM image is displayed in L size (138 x 138 pixels).
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6.5.3 Directory display feature

Selecting a folder that contains images displays the images contained in the folder in the index-image screen.
Selecting an image in the index-image screen displays information on the image in the biank field under the

directory display.

Use Text filter: Putting a checkmark to Use Text Filter displays only important information from the fext
data with the same name as the image file. Without a checkmark, the text data are displayed as they are.

Normally, put 2 checkmark to this item.

Directory display { }Scaled—down

SEM images

—Label

Image informafion <

issl sample

Memo

e el AT



6.5.4 Magnified-Image Screen

Tapping the hutten while a scaled-down SEM image is selected on the index-image screen or
double-clicking a scaled-down SEM image switches to the magnified-image screen. In this screen, the
selected SEM image is displayed on the whole screen of the personal computer. The menu shown below
appears in the upper left comer of the magnified-image screen. The rest of this section explains the functions

of this menu.

| Terminates the rﬁééﬁif‘iéd-lrﬁ'agé éd}een 'a'nd‘fefufn:é."io the iﬁdex-i’rriaée) :

screen.

Set Original size

Sets the number of pixels of a SEM image to the dot size of the screen

to magnify the SEM image.
Some display types do not allow you to observe the whole SEM image
due to their resolution. When Set Original size is selected, you can drag

an image to an arbitrary position in the magnified-image screen.

Set Screen size

Fits the entire SEM image to the display size. With Set Screen size

selected, tapping [Close or tapping in the magnified-image screen
terminates the magnified-image screen and returns to the index-image

§creen.

Back

Magnifies and displays the image immediately preceding the present
one in the index-image screen.

Next

Magnifies and displays the image immediately following the present one
in the index-image screen.

button

The scissors button. Tapping this bufton changes the pointer to
scissors. In the magnified-image screen, dragging the mouse over
the region you want to cut and tapping the button at the lower -
right of the frame cuts the selected region to the clipboard. At this
time, the numbers of pixels of the cutout region appears at the upper left
of the screen. At the same time, the screen capture tool appears,
showing the cutout image.

You can change the size of the selected region by clicking on the
disptayed numbers of pixels and entering numbers of pixels using the
keyboard. To copy the half size of the image, tap button at upper
left. Dragging the center of the selected region moves its position.

button

The fixed-size image capture buttan. Unlike the scissors button, this
button specifies the same region as the last time. Use this button to
capture images in the same region in the same size continuously. Also,
as with the scissors button, you can change the numbers of pixels and
move the region. The captured image is stored in the clipboard.
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You can easily lay out, print and save SEM images, observation conditions and other information in the

layout sheet. :
The magnification indication of SEM images is calculated based upon the photograph size (which is set in

the sefup screen F"Fig-2). With reference to the layout-sheet screen, when you paste the scaled-down

SEM image displayed in the index-image screen to the layout sheet, the scaled-down SEM image is
automatically adjusted to the photograph size and displayed (Fig-13). The observation conditions and label

belonging to the SEM image are also pasted near the image.
Furthermore, you can easily paste the image in the clipboard and input text such as a comment.
The menu bar and toolbar are available in the layout sheet. The following explanations are given for each

function.

Menu bar e

Tool Bar—— J




6.6.1 Menu bar

6.6.1.a File menu

ol

“ New

Clears the layout sheet. When New is selected, since all the image data
being edited and text data already input are deleted from the screen, be
sure to save necessary layout sheets before seiecting New.

Open

Opens a saved layout shest. When Open is selected, all the layout

'sheet being edited is also deleted.

Save as

Saves the layout sheet that you have made together with the SEM
images and texts such as observation conditions and labels.

You can change the file format from the layout format (*.lay), which
allows editing, to JPEG (90 or 150dpi, *.jpg) or bitmap (90dpi, *.bmp).
The entire [ayout sheet can be stored as a single image.

S When a layout sheet is saved as JPEG, it becomes about a 200KB
file, which can be used as an e-mail attachment.

Open User's layout

Opens a user's layout that is set up and stored in advance. In the user's
layout, you can set up the image area and text area as you like, and add
marks such as company logos. For information on how to set up the
user's layout, see Section 6.1, “User’s Layout.”

Save User's layout

Saves the user's layout you set up. If is stored in C:¥program
Files¥jeol¥smy by default. Unless you save the layout in this location, it
does not appear in the list that is displayed by selecting User’s Layout
from the Setup menu.

When you have made a layout sheet to your liking, it can be saved as a
user's layout. However, Save User's Layout saves only its formats. To
save it together with the image data, right-click the image area and
select Keep image (repeat this procedure for each image).

o
=
=7

—

- Shows the Print window. With the Print window, you can perform
printing and change the setup of the printer

Tapping the button prints the layout.

Tapping the [Setup| button displays the Printer setup
window, where you can make settings such as the paper
size and print direction; for details, see the manual for your

printer.
Tapping the button stops the printing.
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Batch layout print

Lets you print a batch of layout sheets. Selecting Batch layout
print displays the Batch iayout print window as shown below.
Basically, this dialog box shows the layout-sheet files contained
in the working folder of the index-image screen.

If you want to change the folder for batch printing, open a Lay file
contained in your desired folder by selecting Open from the File
menu, or drag and drop it onto the SMile View icon.

N

Desériptio

How to select
layout-sheet files
individually

To select a layout-sheet file individually, click
the layout-sheet file that you want. The
selected layout sheet is shown in blue. To
select additional layout sheet files, click them
while holding the key. To deselect some
specific selected layout-sheet files out of
them, click the specific layout sheet files while
helding the Ctrl key.

Select all

Clicking the Select all button selects all of the
layout sheets shown in the Batch layout print
dialog box.

Cancel

Clicking the Cancel button deselects all the
selécted layout sheets.

Number of copies

Tapping the arrow button sets the number of
copies for printing. Setting of 1 to 99 copies is
possible.

Print

Clicking this starts printing. The layout-sheet
files whose printing has finished are
deselected and return fo the original color.

Stop

Clicking this stops the printing. To resume
printing, tap the Print button again.

Printer Setup

Lets you make settings such as the paper size and print direction.
For details, see the manual for your printer.

Exit

Terminates layout sheet. Nevertheless, the layout sheet under
editing remains in memory until the SMile View program is

terminated. .



6.6.1.b Setup menu

3]
Sets the layout sheet in the vertical direction. When the printer is set to the vertical
direction in Printer Setup, Portrait is automatically selected.
Sets the layout sheet in the horizontal direction. When the printer is set to the
horizontal direction in Printer Setup, Landscape is automatically selected.
Allows you to paste two SEM images, observation conditions and labels at a
predetermined position on the paper. It is also possible to add such things as arbitrary

fext.
Allows you to paste three SEM images, observation conditions and labels at a

predetermined position on the paper. It is also possible to add such things as arbitrary
text.

Allows you to paste four SEM images and labels at a predetermined position on the
paper. However, the observation-condition area is not shown. It is also possible to add
such things as arbitrary text, The direction of the layout sheet automatically becomes
horizontal. '

Opens the User's layout window such as shown in the next page. User’s layouts must
have been saved in advance with Save User’s layout.

Name
Portrait

Landscape

2 images

3 images

4 images

User's Layout

"The User's layout window displays the layout sheets contained in C:\Program Files\jeol\smv. Therefore,

save user's layouts in this folder.
As for the method of making the user's layout, refer to Section 6.6.1, "User’s Layout.”




6.6.1.c Tool menu

Aut'd".function Setup

Allows you to set the text filter, autoratic contrast and brightness (ACB),
image filter, and photograph.
= For details, see Section 6.6.5.

Screen Capture tool

Lets you copy everything on the Windows screen. As with
the scissors button in Section 4.2, "Magnified-lmage
Screen,” you can select a region by dragging the scissors
pointer. Also, with a bitmap image in the clipboard, tapping
the button pastes it into the screen capture fool. You
can paste the image from the screen capture tool onto the
layout sheet by drag and drop. :

The image and color quality in printing differ from the
actual quality on the screen depending upon the resolution

and color palette of the display.
Use this tool to paste data such as EDS analysis resuits other than the SEM

image (BMP image or JPEG image), at the same time.

Symbol

Symbols such as arrows can be pasted on the layout by using drag and drop.
Selecting Symbol displays images; you can add any images to them.

= For details, see Section 6.6.5

HTML Index

Allows you to make HTML files by compiling saved layout files and JPEG
image files. You can display the index images of layouts for viewing with
Internet browser software.

= For details, see Section 6.6.4.

Measurement result

Selecting Measurement result opens the Measurement
result panel such as shown in the next page.

With the Measurement result panel open, performing a
measurement automatically pastes the resuits of
measurement or the results of statistical calculation into the
Measurement result panel. At this time, the results are pasted
into the Measurement result panel, regardless of whether
Data to Clipboard or Statistics to Clipboard in the
Measurement screen has a checkmark. However, with the
Measurement result panel ciosed, the results of
measurement are not applied to that panel. _
The results of measurement are pasted into the upper field of  Byean =10980
the Measurement result panel. If the Read only checkbox 0. =389
has a checkmark, you cannot rewrite the results of |
measurement.

The lower field of the Measurement result panel displays the
maximum value, minimum value, average value, and
standard deviation of the measured data, number of measurement points, and
unit of measurement. Rewriting the results of measurement in the upper field
updates the statistical results in the lower field.

Tapping the button clears all the results of measurement. Tapping the

button copies data from the Measurement result panel to the clipboard.
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6.6.1.d Image List menu

The button allows selection between Minimization and Original size in the index-image screen.

The minimization button of the index-image screen facilitates minimizing of alt the SMile View windows.

6.6.1.e Word menu

Add to Word

“Adds the alsblayéd Iaybut sheet o the ohén Microsoft Word file. If no Word file

is open, a new file s created.

Add to Word <
Compress of color
image >

Compresses the color Images in the layout in JPEG format, and adds them to
Woard. Metafile images are not compressed. Compressing EDS data might
blur the boundaries, so it is recommended that you use Add to Word, which

does not compress data.
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6.6.1.f Toolbar

The layout index button displays the layout
index of layout files saved in the same folder
as the image, and allows you to open the
designated layout file. Batch layout print is
possible by clicking the Print button after
selecting more than one layout. You can
also add layouts to Word.

The print button displays the Print dialog box.

button

button

buiton

The text edit button allows you to edit the observation conditions and labels and
other text on the layout sheet. While holding this button down, click any text area
enclosed with a black line on the layout sheet; then you will be able fo edit directly
the contents of the text area. When characters are too small to see, maximize the
size of the window.

Click the label: then the Text Editor window as shown below appears. Tap the
button, after writing comments in the Text Editor window. To set such things
as font and size, tap the [Fonf button. :

The push button allows you to move the
image, text area and label, for example,
and to change the size. :
While this button is selected, tap the
image or text area, and then the image
or text area is boxed with a blue line. To
move the image or text area, dragitto a
position that you want.

Dragging the blue Hl changes the size of
the image or text area.

On the iayout sheet, the image size and
observation magnification are linked to
each other, so changing the image size
automatically changes the observation
magnification and scale size as well.

ext you want fo
alect.

: ~3

You cah move the
chacked items at

the same time

With this button selected, dragging a
region enables you to move and resize
all the contents in the region including
the image and text area. If you want to
move and resize only the image, label,
and/or text, put a checkmark to the
corresponding items in the displayed
box. Tapping the button cancels

the change.



The layout button allows you to create the SEM image layout. After selecting this
button, tap the layout sheet; then you are able to make the image area,
observation-condition area and label.

The label button allows you to insert the label. After selecting this button, tap the
layout sheet; then the Text Editor window opens. '

A comment line in addition fo the fabel text of the index-image screen can be
pasted on the label on the iayout sheet. Since the background of the label on the
layout sheet can be changed to colorless to make it different from the fext area,
such as comments is pasted without covermg the SEM image except with the

strokes of the characters.

buﬂon

The text button allows you to make a text area. One or more comment or memo
lines can be displayed in the text area. When layout sheets are printed, the frames

of text areas are nof printed.

switch

The ACB switch allows you to switch the Auto Contrast/Brightness (ACB) on or off.
While this switch is checked, the SEM images on the index-image screen can be
pasted on the layout sheet, with automatic adjusiment of the contrast and
brightness of the image (only for grayscale images).
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